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Abstract

These Application Notes describe the procedures for configuring Avaya IP Office Release
9.0.3 to inter-operate with the ThinkTel SIP Trunking Service.

The ThinkTel SIP Trunking Service provides PSTN access via a SIP trunk between an
enterprise site and the ThinkTel network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the business customer.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Avaya IP Office Release 9.0.3 to
inter-operate with the ThinkTel SIP Trunking Service.

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office 500 V2
running Release 9.0 SP3 software, Avaya Preferred Edition (a.k.a VVoicemail Pro) messaging
application, Avaya H.323 and SIP hardphones, and SIP-based Avaya softphones.

The ThinkTel SIP Trunking Service provides PSTN access via a SIP trunk between an enterprise site
and the ThinkTel network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the business customer.

For brevity, the remainder of this document mostly refers to the ThinkTel SIP Trunking Service
simply as ThinkTel.

The terms “Service Provider” and “ThinkTel” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to ThinkTel via the public Internet. The configuration shown in Figure 1 was used to
exercise the features and functionality tests listed in Section 2.1

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered during
the compliance test.

e SIP OPTIONS queries and responses.

e Incoming calls from the PSTN to H.323 and SIP telephones at the enterprise. All inbound
PSTN calls were routed to the enterprise across the SIP trunk from the service provider.

e Outgoing calls to the PSTN from H.323 and SIP telephones at the enterprise. All outbound
PSTN calls were routed from the enterprise across the SIP trunk to the service provider.

e Various call types including: local, long distance, outbound toll-free, international, and Local
Directory Assistance (411) calls.

e G.711MU and G.729A codecs.

e Caller ID presentation and Caller ID restriction.

e DTMF transmission using RFC 2833.
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Voicemail access and navigation for inbound and outbound calls.

Telephony supplementary features such as hold and resume, transfer, and conference.
Off-net call forwarding and call transfer/conference.

Twinning on inbound calls to PSTN mobile phones.

e Use of the SIP REFER method for transferring calls off-net to the PSTN.

e Inbound and outbound long-duration call stability.

e Inbound and outbound long hold time call stability.

e Response to incomplete call attempts and trunk busy or error conditions.

e T.38and G.711 pass-through fax.

2.2. Test Results

Interoperability compliance testing of the ThinkTel SIP Trunking Service was completed with
successful results for all test cases with the exception of the observations/limitations described
below.

e OPTIONS Response — On the test circuit used for the compliance test, ThinkTel responded
to OPTIONS from IP Office with "401 Unauthorized" instead of "200 OK". For ThinkTel to
respond to OPTIONS with “200 OK”, it requires that the OPTIONS message contain an
Authorization header, but Avaya IP Office cannot be configured to satisfy this requirement.
However, IP Office treats any response to OPTIONS as an indication that the far end is
active and responding, therefore will not take the SIP connection to the far end out of
service. This OPTIONS response is listed here simply as an observation since it had no
impact on the status of the SIP connection between IP Office and ThinkTel.

e Digest Authentication — Only the first outbound call after IP Office was rebooted would
show the usual challenge/response exchange of Digest Authentication (1st outbound
INVITE eliciting 401 message back as challenge, thereupon a 2nd outbound INVITE
containing the required authentication data as response). After that, the outbound calls
would contain an Authorization header specifying all the required authentication
information; therefore the Digest Authentication handshake was obviated.

e Codec Lockdown —When the SDP of an outbound call INVITE contained the codec list of
G.729A and G.711MU in that preference order, ThinkTel's call connect "200 OK" contained
the same codecs in same order in the SDP instead of the single preferred codec (G.729A).
However, When the SDP of outbound INVITE contained the codec list in the order of
G.711MU and G.729A, ThinkTel's call connect *200 OK" contained the single preferred
codec (G.711MU). This difference in codec lockdown behavior is listed here simply as an
observation since there was no user impact.

e Unsupported Codec — When outbound call was configured to use a codec unsupported by
ThinkTel, ThinkTel would return a 183 Session In Progress” message whose SDP
contained G.711MU. IP Office would then terminate the call by issuing the CANCEL
message. While this behavior was acceptable, it would be more desirable for ThinkTel to
return an explicit status message, like "488 Not Acceptable Here" or "415 Media Type
Missing™ in response to the outbound INVITE. ThinkTel opened an enhancement ticket to
its platform vendor for this issue.
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e REFER Signaling — When the SIP REFER method was used for off-net call re-direction,
ThinkTel would issue an INVITE towards the IP Office caller after issuing BYE's, upon
accepting the REFER from the enterprise, to terminate the calls between the PSTN
endpoints and the IP Office caller (so that IP Office would no longer anchor the calls after
the call re-direction). This INVITE would elicit an IP Office response of “481
Dialog/Transaction Does Not Exist” since the call had already been terminated by ThinkTel.
This untidy signaling exchange had no user impact; off-net call re-direction using REFER
was successfully tested/verified.

e Direct Media — Avaya IP Office R9.0 offers a new Direct Media capability on IP Office 500
V2 that allows IP endpoints to send RTP media directly to each other rather than having all
the media flow through the IP Office, using up VoIP and relay resources. This capability is
not supported on the configuration described in these application notes where Avaya IP
Office connects to the service provider network via a direct public Internet connection
without using an enterprise Session Border Controller.

Items not supported or not tested include the following:

e Inbound toll-free and emergency calls (911) were not tested as part of the compliance test.

e ThinkTel does not support Operator (0) and Operator-Assisted (0 + 10-digits) calls.

e ThinkTel does not support SIP session timer refresh. ThinkTel did not initiate session refresh
via SIP re-INVITE or UPDATE messages, and no message headers for session refresh
handshake were contained in SIP messages from ThinkTel. In the compliance test, session
refresh for active calls was initiated from IP Office.

2.3. Support

For technical support on ThinkTel SIP Trunking Service, contact ThinkTel technical support at:
e Phone: 1 (866) 928-4465
e Email: support@thinktel.ca
e Website: http://support.thinktel.ca/

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 illustrates the test configuration showing an enterprise site connected to the ThinkTel SIP
Trunking Service.

Located at the enterprise site is an Avaya IP Office 500 V2 running the Release 9.0 SP3 software.
Endpoints include various Avaya IP Telephones (with H.323 and SIP firmware) and SIP-based
Avaya softphones (Avaya IP Office Video Softphone and Avaya Flare® Experience for Windows).
The site also has a Windows PC running Avaya Preferred Edition (a.k.a. Voicemail Pro) for
providing voice messaging service to the Avaya IP Office users, and Avaya IP Office Manager for
administering the Avaya IP Office.
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Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

Service Provider
ThinkTel

PSTN Phone

SIP Trunking Service

A | 192.168.250.100

A

< & |
Fax \f.’_%dobile Twinning Internet
SIP;
1
1
I
Avaya
192.168.96.231
i IP Office 500 V2
10.32.128.30
Fax

IP Office Video  Avaya Flare® P Office

Softphone (SIP) Experience for

Avaya 1600 Series Avaya 96x1 Series
IP Phone (H.323) IP Phone (H.323) Windows (SIP) Voicemail Pro

Avaya 96x0 Series IP Office
IP Phone (H.323) Avayg;;ligglﬂoo Manager
IP Phone (SIP)
Business Site
Figure 1: Avaya IP Office with ThinkTel SIP Trunking Service
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For security purposes, any actual public IP addresses used in the compliance test were changed to
192.168.x.x throughout these Application Notes.

During compliance testing, Avaya IP Office users dialed a short code of 8 or 9, plus N digits to send
digits across the SIP trunk to ThinkTel. The short code (8 or 9) was stripped off by Avaya IP Office
but the remaining N digits were sent to the service provider network. For calls within the North
American Numbering Plan (NANP), the user dialed 11 (1 + 10) digits for long distance and local
calls. Thus, for these NANP calls, Avaya IP Office sent 11 digits in the Request URI and the To
header of an outbound SIP INVITE message. ThinkTel sent 10 digits in the Request URI and the To
header of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and Avaya IP Office such as a Session Border Controller
or data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

The administration of the Avaya Preferred Edition (Voicemail Pro) messaging service and endpoints
on Avaya IP Office is standard. Since these configuration tasks are not directly related to the inter-
operation with the ThinkTel SIP Trunking Service, they are not included in these Application Notes.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment / Software Release / Version
Avaya IP Office 500 V2 9.0.3.0 build 941
Avaya IP Office COMBO6210/ATM4 Module 9.0.3.0 build 941
Avaya IP Office Manager 9.0.3.0 build 941
Avaya Preferred Edition (a.k.a Voicemail Pro) 9.0.3.0 build 212
Avaya 1616 IP Telephones (H.323) Avaya one-X Deskphone 1.3 SP5
Avaya 9611G IP Telephones (H.323) Avaya one-X Deskphone

6.3.1.16 V452
Avaya 9630G IP Telephones (H.323) Avaya one-X Deskphone 3.212A
Avaya 1120E IP Telephone (SIP) 4.04.14.00
Avaya IP Office Video Softphone (Windows) 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23
ThinkTel Components

Equipment / Software Release / Version
Metaswitch 7.4
Opensips Session Border Controller 1.6.2
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Testing was performed with IP Office 500 V2, but this testing also applies to Avaya IP Office Server
Edition running the same version of software. Note that IP Office Server Edition requires an
Expansion IP Office 500 V2 to support analog or digital endpoints or trunks.

5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the PC
running Avaya IP Office Manager, select Start = Programs - IP Office & Manager to launch
the application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Open Configuration from Swstem

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File = Open Configuration at the top of the Avaya
IP Office Manager window. Select the proper Avaya IP Office system from the pop-up window and
log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the screens
presented in this document, the View menu was configured to show the Navigation Pane on the left
side, omit the Group Pane in the center, and show the Details Pane on the right side. Since the Group
Pane has been omitted, its content is shown as submenus in the Navigation Pane. These panes
(Navigation and Details) will be referenced throughout the Avaya IP Office configuration.

All licensing and feature configuration that is not directly related to the interface with the service
provider (such as twinning and IP Office Softphone support) is assumed to already be in place.

In the sample configuration, Jersey City was used as the system name. All navigation described in
the following sections (e.g., License = SIP Trunk Channels) appears as submenus underneath the
system name Jersey City in the Navigation Pane. The configuration screens highlight
values/settings configured for the compliance test. Defaults were used for other values and may be
customized based upon requirements in the field.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an
authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in the
Navigation Pane. Confirm a valid license with sufficient Instances (trunk channels) in the Details
Pane. The screen below also shows the valid license for Avaya IP endpoints.

"] Avaya IP Office Manager Jersey City [9.0.300.941] [Administrator{Administrator)]

File ~ Edit View Tools Help
W o \ 5
25-dIAREIEW v > 2 8
IP Offices ek-MX|v|<]|>
®- & BOOTP(2) License | Remote Server
[# {7 Operator (3) ¢ z )
[=)-%%5 Jersey City License Mode  License Normal |
G- System (1) PLDSHost 1D 111311587034
#-T7 Line (8)
":t“ = Contro! Unit (2) | Feature License Key Instances Status S Add...
f‘ & Extension (17) Report Yiewer b, + . + 255 Yalid
@ User (18) Mobility Features R R - 255 Obsolete Remove
[-5g Group (1) IPS00 Yoice Networking Channels . om 255 Yalid
(#-@% Short Code (66) 1PS00 Yoice Networking Channels e e " v - 4 Valid
@ Service (0) YCM Channel Migration - - 255 Valid
o &m0 P —— o — =
; niversal itional chan... it SRR al
=9 Iwngilm":gtc;" Route (15| | a5 LRQ Support (Rapid Response) A - " 255 yalid
@ /AN Port (0) IP Office Dealer Support - Standard E... w e . ' 255 valid
"5 D‘"'eCtOW‘(O) IP Office Dealer Support - Profession... s = 255 Yalid
£ Time Profile (0) IP Office Distributor Support - Standa... b + . 255 valid
[+ @ Firewall Profile {1) IP Office Distributor Support - Profes... el - 255 valid
- [§ll 1P Route (4) UMS Web Services - - 255 Valid
&m Account Code (0) CCR SUP ) s g - ” 255 Val!d
PN icense (64) Custome'r Service Agent e - " oot 255 Val!d
W T 10 CCR Designer " - - 255 Valid
b tnnel (0) CCR CCC UPG R . v 255 walid
-5 User Rights (8) 1600 Series Phones i ot it 255 valid
- ARS (2) Third Party APT ' = + = 255 Valid
" RAS Location Request (0 one-% Portal for IP Office ot e i 255 Valid
& Location (0) | Avava IP endpoints - ] . ¥ 255 Valid |
Customer Service Supervisor st - - 255 Valid
Essential Edition Additional VYoicemail ... o o “ et ¢ 255 valid
Teleworker . ‘ i e oy o 255 Yalid
Mobile Worker b - ' ‘ 255 Yalid
Power User . - 255 Valid
Advanced Edition - -t 255 Yalid |
Office Worker . ¢ - .- 255 Yalid Ml
< 3|
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To view the physical hardware comprising the Avaya IP Office system, expand the components
under the Control Unit in the Navigation Pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital station ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary to

support SIP trunking.

To view the details of the component, select the component in the Navigation Pane.

The screen below shows the details of the IP 500 V2:

IP Offices =] IP 500 V2 e

- & BOOTP(2)

[# 47 Operator (3)

ersey City

% System (1)

#-F4 Line (8)

(=)= Control Unit (2)
“
<2 2 COMBOG6210/ATM4

-4 Extension {17)

#@ User(18)

5@ Group (1)

(#- 8% Short Code (66)

B service (0)
ol RAS (1)
# € Incoming Call Route (15)
8 wan Port (0)
a4 Directory (0)
£ Time Profile (0)

@ Firewall Profile (1)

# [l 1P Route (4)

&g Account Code (0)

. License (64)

Unit ‘

Device Number

Unit Type

Version

Serial Number

Unit IP Address
Interconnect Number

Module Number

[5Gl

1

1P 500 v2

[9.0.300.941

(10.32.128.30

o

Control Unit

The screen below shows the details of the Combination Card:

IP Offices

& & BOOTP (2)
+ Operator (3)

()

% System (1)
#- 4 Line (8)
(=)= Control Unit (2)
< 11IPS00 V2
-
-4 Extension {17)
#@ User(18)
5§ Group (1)
# @% Short Code (66)
B service (0)
ol RAS (1)
# € Incoming Call Route (15)
8 wan Port (0)
o Directory {0)
£ Time Profile (0)
@ Firewall Profile (1)
@ IP Route {4)
&g Account Code (0)
W License (64)

E COMBO6210/ATM4 e

Unit ‘

Device Number

Unit Type

Version

Serial Number

Unit IP Address
Interconnect Number

Module Number

| X | v |<|

|2

|comBos210/ATM4

9.0.300.941

[0.0.0.0

o

|control Unit
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5.2. System
This section configures the necessary system settings

5.2.1. System - LAN2 Tab

In the sample configuration, Jersey City was used as the system name and the WAN port (LAN2
port) was used to connect the Avaya IP Office to the public network. The LAN2 settings correspond
to the WAN interface on Avaya IP Office. To access the LAN2 settings, first navigate to System -
Jersey City in the Navigation Pane and then navigate to the LAN2-> LAN Settings tab in the
Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office WAN port.
Set the IP Mask field to the mask used on the public network.

IP Offices

#- R BOOTP(2)

+ ¢/ Operator (3)

= %%y Jersey City
=%y System (1)

vl Jersey City

#-TH Line (8)
&= Control Unit (2)
(4@ Extension {17)
@ § User(18)
[+ 5§ Group (1)
[# @3 Short Code (66)
@ Service (0)
o RAS (1)
@ Q Incoming Call Route {15)
€9 wan Port (0)
o Directory (0)
£ Time Profile (0)
@ Firewal Profile (1)
] IP Route {4}
@ Account Code (0)
W, License (64)
W& Tunnel (0}
@ fq User Rights (8}
g ARS (2)
« RAS Location Request (0}
5 Location (0)

ﬁ Jersey City” £ | X | v |<|

System | LAN1 | LANZ | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR || Codecs | ACCS
LAN Settings | yoIP | Network Topology

IP Address :7192 168 96 231 3

1P Mask i255 255 ..255 . 224

Primary Trans. IP Address 0 0 0 o |

Firewall Profile <Mone> vi

RIP Mode None i
[[] Enable NAT

=

Number OF DHCP IP Addresses (200 3|
DHCP Mode
O server O client O Dialin (¥ Disabled
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On the VoIP tab of LANZ in the Details Pane, configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e Inthe RTP section, the RTP Port Number Range can be customized to a specific range of
receiving ports for the RTP media. Based on this setting, Avaya IP Office would request RTP
media be sent to a port in the configurable range for calls using LAN2,

e Inthe Keepalives section, select RTP for Scope; select Enabled for Initial keepalives; enter
30 for Periodic timeout. These settings direct IP Office to send a RTP keepalive packet
starting at the time of initial connection and every 30 seconds thereafter if no other RTP
traffic is present. This facilitates the flow of media in cases where each end of the connection
is waiting for media from the other, as well as helping to keep firewall ports open for the
duration of the call.

x

P Jersey City” £ | X |« | < |

System | LaN1 | LANZ |DNS | Yoicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | YCM | CCR | Codecs | ACCS
LAN Settings | YoIP | Network Topology ‘

=
H323 Gatekeeper Enable |
[] Auto-create Extn Auto-create User [] H323 Remote Extn Enable
| SIP Trunks Enable |
SIP Registrar Enable
[] auto-create ExtnfUser [] s1P Remote Extn Enable
Domain Name V
UpP UDP Port (5060 2] RemoteuDPPort [S00
Layer 4 Protocol TCP TCP Port 35060 3| Remote TCP Port \
O s TLSPort (5061 2] RemoteTisPort [5061
Challenge Expiry Time {secs) |10 =
RTP
Port Mumber Range
Minirmurn 49152 & Maximurm 53246 3
Port Number Range (NAT)
Minimum o152 § Maxirmum 53246 3|
Enable RTCP Monitoring on Port 5005
Keepalives
Scope |RTP v Periodic timeout 30
Initial keepalives Enabled v|
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Scroll down to the DiffServ Settings section. Avaya IP Office can be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to support Quality
of Services policies for both signaling and media. The DSCP field is the value used for media and
the SIG DSCP is the value used for signaling. The specific values used for the compliance test are
shown in the screen below and are also the default values. For a customer installation, if the default
values are not sufficient, appropriate values should be provided by the customer.

2%

Y Jersey City”™ £ |. % | |<

| System | LAN1 | LANZ | DNS | Woicemail || Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR || Codecs | ACCS
LAN Settings | YoIP | Network Topology | ‘

Keepalives Al
Scope [RTP v ‘ Periodic timeout |30
Initial keepalives |Enabled v ‘

DiffServ Settings

B8 | DscP(Hex) B8 3| videoDscP(Hex) FC & DSCPMask(Hex) 88 £ sIGDSCP (Hex)
46 3| psce 46 3| video DSCP | 5

| DSCP Mask 34 3| sigosce

DHCP Settings

Primary Site Specific Option Number (SSON) 176 3;
Secondary Site Specific Option Number (SSON) 242 3}1
YLAN Mot Present :
1100 Yoice YLAN Site Specific Option Number (SSON) 232 3 ‘
1100 Voice YLAN IDs
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On the Network Topology tab of LAN2 in the Details Pane, configure the following parameters:

e Select Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With the
Open Internet setting, STUN Server Address is not used.

e Set Binding Refresh Time (seconds) to a desired value. This value is used as one input to
determine the frequency at which Avaya IP Office will send SIP OPTIONS messages to the
service provider. See Section 5.9 for complete details.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e Set Public Port to 5060 for UDP.

=Y Jersey City* £ | X | v |

System | LAN1 | LANZ | DNS || Voicemail | Telephony | Directory Services | System Events | SMTP || SMDR || Twinning | ¥CM | CCR | Codecs | ACCS

LAN Settings | voIP | Network Topology |

Metwork Topology Discovery

STUN Server Address i STUN Port i3473 7 3‘
Firewall{NAT Type | Qpen Internet ¥
Binding Refresh Time {seconds) }80 | 3‘
Public IP Address 192 . 168 . 9% . 231 | Cancel
Public Port
UDP 5060 A
Tce o =]
s o =

During compliance testing, the LANL1 interface was used to connect the Avaya IP Office to the
enterprise site IP network. The LANL1 interface configuration is not directly relevant to the interface
with ThinkTel, and therefore is not described in these Application Notes.
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5.2.2. System - Voicemail Tab

In the VVoicemail tab of the Details Pane, configure the SIP Settings section. The SIP Name and
Contact are set to one of the DID numbers provided by ThinkTel. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. Uncheck the Anonymous box to allow
the Voicemail Caller ID information to be sent to the network.

Note the selection for Voicemail Type and the IP address setting for Voicemail IP Address. These
are for configuring VVoicemail Pro as the voice messaging service for Avaya IP Office users (part of
the standard IP Office setup beyond the scope of these Application Notes).

Ko

= Jersey City - | X |« ]|<|

| System | LAN1 || LANZ | DNS Yoicemail Telephony | Directory Services | System Events | SMTP | SMDR | Twinning || YCM CCR Codecs | ACCS

Yoicemail Type Yoicemail Lite/Pro [[] Messages Button Goes To Visual Yoice

oicemail Destination

Voicemail IP Address [10 32 128 . 78 |

Backup Yoicemail IP Address | 0 0 0 0
Voicemail Channel Reservation

Unreserved Channels }'23? \

Auto-Attendant 2 3| voice Recording i5 =) Mandatory Voice Recording 3 = A
Announcements ‘5 2| Maibox Access ‘5 v ‘\
DTMF Breakout
Reception [ Breakout (DTMF 0) ‘ v ‘
Breakout (DTMF 2) } v
Breakout (DTMF 3) bl
SIP Settings
SIP Mame 4388960444
SIP Display Name (Alias) Voicemail i
Contact 4355960444
Anonymous [:l
Call Recording
Auto Restart Paused Recording (secs) (15 =
Hide Auto Recording O
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5.2.3. System - Telephony Tab

Navigate to the Telephony = Telephony tab in the Details Pane. Enter or select 0 for Hold
Timeout (secs) so that calls on hold will not time out. Choose the Companding Law typical for the
enterprise site. For the compliance test, U-LAW was used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the service
provider across the SIP trunk per customer business policies. Note that this configuration might pose

a security issue (Toll Fraud). Customers should exercise caution with this configuration.

Jersey City £ | 2

| v | < |

| System | LAN1 | LANZ || DNS { Voicemail} Telephony ‘Directory Services I System Events | SMTP | SMDR VTwinning VCM VCCR Codecs I ACCS

| Telephony lPark&Page | Tones & Music | Ring Tones || SM CallLog | TUI
A |
Analogue Extensions Companding Law |
- 1 Switch Line
Default Outside Call Sequence | Normal v
Default Inside Call Sequence ERing Type 1 v | ® U-Law (® U-Law Line
Default Ring Back Sequence |Ring Type 2 |
d & ik 2L L — O a-Law O a-Law Line
Restrict Analogue Extension Ringer Voltage O
Dial Delay Time (secs) f = [] Dss Status
Dial Delay Count 0 * } GLidin
| | i v N
Default Mo Answer Time (secs) i15 =l DR By Hael
] v
Hold Timeout {secs) 0 £ ll o fcantCore
Bk et oees) o 3 ] Inhibit Off-Switch ForwardTransfer
imeoul f v
R DA (o8 5 x| [[] Restrict Metwork Interconnect
ing Delay (secs f v
— . [] orop External Only Impromptu Conference
Call Priority Promotion Time (secs) |Disabled = [
- p— [ visually Differentiate External Call
Default Currency |UsD v
= z ‘ [ unsupervised Analog Trunk Disconnect Handling
Default Name Priority |Favor Trunk v
= —_— High Quality Conferencing
Media Connection Preservation | Disabled v |
B e [] strict 51PS
Digitaljanalogue Auto Create User
D
AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 15 of 38

SPOC 10/3/2014

©2014 Avaya Inc. All Rights Reserved.

TT-SipTrkIPO9




5.2.4. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details Pane
as shown in the following screen. The Send original calling party information for Mobile

Twinning box is not checked in the sample configuration, and the Calling party information for
Mobile Twinning is left blank.

K
Ko

= Jersey City £ 1 -l S e

System | LAN1 | LANZ | DNS Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR ‘ Twinning |yCM | CCR | Codecs | ACCS

[] send original calling party information for Mobile Twinning

Calling party information for ‘ ]
Mobile Twinning L ‘

5.2.5. System — Codecs Tab

In the Codecs tab of the Details Pane, select or enter 101 for RFC2833 Default Payload. This setting
was recommended by ThinkTel for use with out-band DTMF tone transmissions.

= Jersey City £ | X |« | < |
;Systemw LANI || LANZ | DNS | Yoicemail | Telephony | Directory Services | System Events! SMTP | SMDR | Twinning | ¥CM | CCR 7‘ Codecs iACCS |
l RFC2833 Default Payload ‘i'}'o'i B 3\ I

Available Codecs Default Codec Selection

Unused Selected ;

(@] G.711 ULAW 64K ' = [G.711 ULAW 64K

|[#] G.711 ALAW 64K |G.711 ALAW 64K

4 |G.729(a) 8K CS-ACELP

M G.722 64 |G.723.1 6K3 MP-MLQ

|[7] G.729(a) 8K C5-ACELP << |G.722 64K

|[¥] G.723.1 6K3 MP-MLQ

e e ‘

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 16 of 38
SPOC 10/3/2014 ©2014 Avaya Inc. All Rights Reserved. TT-SipTrkIPO9




5.3. IP Route

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New (not shown). Create
and verify a default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.
e Set Gateway IP Address to the IP address of the gateway for the public internet network.
e Set Destination to LAN2 from the drop-down list.

IP Offices

# R BOOTP(2)
[#-¢7 Operator {(3)
=-%% Jersey City
[# %29 System (1)
#-FH Line (6)
{# = Control Unit (2)
[+ -4 Extension (16)
@ User(18)
#-5f Group (1)
(# 8% Short Code (65)
B service (0)
®-o; RAS (1)
® g Incoming Call Route (19)
8 wanPort (0)
o Directory (0)

£ Time Profile (0)
- @ Firewall Profile (1)
=] IP Route (4}
Kl 0.0.0.0
Bl 10.32.0.0
Bl 152.168.0.0
Bl 192.168.99.0

@ Account Code (0)

Ei
| 1P Route |

1P Address

1P Mask

0.0.00"

Gateway IP Address | 192 . 168

Destination

Metric

k@ X[ v |

| >

D Proxy ARP

<3|
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5.4. Administer SIP Line

A SIP Line is needed to establish the SIP connection between Avaya IP Office and ThinkTel. The
recommended method for configuring a SIP Line is to use the template associated with these
Application Notes. The template is an .xml file that can be used by IP Office Manager to create a
SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses

SIP Credentials (if applicable)

SIP URI entries

Setting of the Use Network Topology Info field on the SIP Line Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated after the SIP Line
is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.4.2 through 5.4.6.

Also, the following SIP Line settings are not supported on Avaya IP Office Basic Edition:

e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

5.4.1. Create SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to CA_ThinkTel_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the option box is checked next to Enable
Template Options. Click OK.

K4l 1P Dffice Manager Preferences @@

Preferences | Directories | Discovery | Visual Preferences | security || walidation

Icon Size |Small w
Mulkiling Tabs
Enable Template Options
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3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

™ Avaya IP Office Manager Jersey City [9.0.300.941] [Admin

File  Edit View | Tools I Help

R ES-HIE Extension Renumber...
Line Renumber...
P om I
Connect To...
@ x BOOTP (2) B y pobility
[+ ¢~ Operator (3) 2
= Jersey City SCN Service User Management D Iy
[+ %=y System (1) & i
@ 17 Line (8) Busy on Held Yalidation
<= Control Unit MSN Configuration
[+ 4 Extension (]
o Uiser (15)
& apf Group (1) Import Templates in Manager
[+ 8% Short Code (57
&3 sService (0) Full Name

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue.

If preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk From Template.

IP Offices SIP Line -Line 17

@ K BOOTP (2) | SIP Line [Transport | SIP LRI VoIP | 138 Fax| SIP Credentials
[#-47 Operator (3) } 22 B ) ) ;
(=529 Jersey|+ Mew 5 -
o Syl A H323 Line
@ T4 L <9 Generate SIP Trunk Template IP DECT Line
#-<= Co SIP Line
W & Exl & Cut Chri+x ,
3 a Us{ > SM Line L
=3 Copy Chrl+C ‘
+ g Gr ) . SIP DECT Line :
G s R, 5 I Mew SIP Trunk From Template JJ
@B 5ef X | Delete Ctrl+Del
B ollg RA + Validate ’. |
# P Ing ‘ .
£ ws Rnec ' \ \
s Dir Mew from Template (Binar
£ Tind et ) 7 \Divgrsjon Header v ‘
24 @ Fir Export as Template (Binary) :
I%‘ T ASSUCIEUOTT e O [BV Source IP address v
[+ IP Route {(4) el
#m Account Code (0)
&, License (64) ‘

5. In the subsequent Template Type Selection pop-up window, select United States from the
Country drop-down list and select ThinkTel from the Service Provider drop-down list as
shown below. These values correspond to parts of the file name
(CA_ThinkTel_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish
creating the trunk.

W Template Type Selection

Locale ; a5 (U ‘
Country fcaraca 4
Service Provider ﬁhka;I ~Z\ [] Display &l

[ Create new SIP Trunk ] [ Cancel ]

Note that the newly created SIP Line may not immediately appear in the Navigation pane
until the configuration was saved, closed and reopened in IP Office Manager.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2 through 5.4.6.
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5.4.2. SIP Line - SIP Line Tab
In the SIP Line tab of the Details Pane, configure the parameters as shown below:

T ronees B

®- & BOOTP(2)

t

Set ITSP Domain Name to the IP address of the service provider SIP Trunking access
interface (provided by ThinkTel) which the SIP Line is connecting to.

Check the In Service box.

Check OOS box. Avaya IP Office will check the SIP OPTIONS response from the far end to
determine whether to take the SIP Line out of service.

Set Call Routing Method to Request URI. Avaya IP Office will route inbound calls based
on the number in the Request URI.

Set Send Caller ID to Diversion Header. With this setting and the related configuration in
Section 5.2.4, Avaya IP Office will include the Diversion Header for calls that are redirected
via Mobile Twinning out the SIP Line to the PSTN. It will also include the Diversion Header
for calls that are forwarded out the SIP Line.

Check REFER Support, then select Always for Incoming and Outgoing. ThinkTel supports
using REFER message for off-net call re-direction as in call transfer.

Set Method for Session Refresh to Auto. With this setting Avaya IP Office will send
UPDATE messages for session refresh if the other party supports UPDATE. If UPDATE is
not supported, re-INVITE messages are sent.

Set Session Timer (seconds) to a desired value. Avaya IP Office will send out session
refresh UPDATE or re-INVITE at the specified intervals (half of the specified value)

SIP Line - Line 17 ek-MI X vl<]|s

SIP Line (Transport [SIP URI| VoIP | T38 Fax| SIP Credentials

1/ Operator (3)
(= %%y Jersey City
=) %=y System (1)
w2 Jersey City
=7 Line (8)
™
12
13
14
~ fEll
., 18
", 19
", 20
<= Control Unit (2)
(# 4@ Extension {17)
@ § User(18)
[+ 5§ Group (1)
+-@% Short Code (66)
B service (0)
o RAS (1)
@ @ Incoming Call Route (15)
€9 wan Port (0)
a4 Directory (0)
£ Time Profile (0)
# @ Firewall Profile (1)
+ [l 1P Route (4)
#m Account Code (0)
W License (64)
W& Tunnel (0)
@ fq User Rights (8}
# ¢ ARS(2)
« RAS Location Request (0}
5 Location (0)

Line Number

73

¥

ITSP Domain Mame

192.168.250.100

| | In Service |

Prefix
National Prefix
Country Code

International Prefix

URI Type sIp v

Check 005

Call Routing Method Request URI v

Originator number for
forwarded and twinning calls

MName Priority System Default v

Send Caller ID

Diversion Header

Caller ID from From header  []

Association Method

By Source IP address

Send From In Clear O

User-Agent and Server
Headers
Service Busy Response 486 - Busy Here v

Action on CAC Location Limit | Allow Yoicemail e

REFER Support

Incoming

QOutgoing

Always

Always

Method for Session Refresh

Session Timer (seconds)

Auto

600

Media Connection Preservation | Disabled
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5.4.3. SIP Line — Transport Tab
Navigate to the Transport tab and set the following:

e Setthe ITSP Proxy Address to the IP address of the service provider SIP Trunking access
interface (provided by ThinkTel) which the SIP Line is connecting to.

e Setthe Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LAN2 as configured in Section 5.2.1.

e Set the Send Port to 5060.

by SIP Line -Line 17* k- | X|v|<]|>

SIP Line| Transport |SIp URI|voIP || T38 Fax|SIP Credentials

|ITSP Proxy Address |192.168.250.100 |

Metwork Configuration

Layer 4 Protacol |uDp v/ Send Port 35060 =
Use Network Topology Info [Lan 2 v ‘ 1
Explict DNSServer(s) |0 . 0 . 0 . 0 ||0 .0 .0 . 0|

Calls Route via Registrar

Separate Reqgistrar “
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5.4.4. SIP Line — SIP Credentials Tab

SIP Credentials are used to register the SIP Trunk with a service provider that requires SIP Registration.
SIP Credentials are also used to provide the required information for Digest Authentication of outbound
calls. SIP Credentials are unique per customer and therefore customers must contact the service provider
to obtain the proper registration credentials for their deployment.

Select the SIP Credentials tab, and then click the Add button and the New Channel area will appear at
the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit...
button. The screen below shows a sample entry being edited.

e Set User name and Authentication Name to the registration string provided by the service
provider. This is generally a 10-digit telephone number as shown below.

e Set the Contact field to the value provided by the service provider.
e Inthe Password field, enter the password provided by the service provider.
e Inthe Expiry (mins) field, enter the time in minutes.

e Check the Registration required field if Registration is required for the SIP Trunking customer
account, otherwise leave it unchecked. For the compliance test, ThinkTel did not require trunk
registration.

= SIP Line - Line 17 -9 X|v|<]>
SIP Line| Transport | SIP URI| ¥oIP | T38 Fax| SIP Credentials »
Index  UserName Authentication Mame  Contact Expiry {mins)  Register 1 Add...
1 4385960434 4358960434 4388960434 60 False
Remove
Edit...
: Edit SIP Credentials
User name 1388960434 |
Authentication Name 4388960434 3
Contact 4388960434
Password sessscee
Expiry {mins) 50 :‘
Registration required D
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5.4.5. SIP Line — SIP URI Tab

Select the SIP URI tab to create or edit a SIP URI entry. A SIP URI entry matches each incoming
number that Avaya IP Office will accept on this line. Click the Add button and the New Channel
area will appear at the bottom of the pane. For the compliance test, a single SIP URI entry was
created to match any DID number assigned to Avaya IP Office users. The following screen shows
the edit window on a previously configured entry for the compliance test.

e Set Local URI to Use Internal Data. This setting allows calls on this line whose SIP URI
matches the SIP Name set on the SIP tab of any User as shown in Section 5.6.

e Set Contact and Display Name to Use Internal Data. This setting will cause the Contact
and Display Name data for outbound messages to be set from the corresponding fields on the
SIP tab of the individual User as shown in Section 5.66.

e Set PAI to Use Internal Data. This setting directs Avaya IP Office to send the PAI header
(P-Asserted-ldentity) when appropriate. The PAI header will be populated from the data set
in the SIP tab of the call initiating User as shown in Section 5.66.

e Select the Registration value that was configured in Section 5.4.4.

e Associate this line with an incoming line group by entering line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. For the compliance test, 17 was specified for both the incoming and the
outgoing group. Note that this group number can be different than the SIP Line number.

e Set Max Calls per Channel to the number of simultaneous SIP calls allowed.

= SIP Line - Line 17 kM X|v|<|>
SIP Line| Transport| 3IP URI |yoIP | T38 Fax| SIP Credentials
Channel  Groups Via Local URI Contact Display Name PAI Add...
1 17 17 ) b
Remove
Edit...
Edit Channel
Via 1192.168.96.231
|
ILocaI URI |Use Internal Data v |
Contact \Use Internal Data v |
Display Name |Use Internal Data v |
IPAI §Use Internal Data v |
IRegistration | 1: 4388960434 v
Incoming Group 117
Outgoing Group ‘17
|Max Calls per Channel 110 >
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5.4.6.

SIP Line — VoIP Tab

Select the VoIP tab. Set the parameters as shown below.

K

Set the Codec Selection to Custom.

Choose G.711 ULAW 64K and G.729(a) 8K CS-ACELP from the Unused box and move
these two selections to the Selected box. Use the up and down arrows in the middle to order
these 2 codes. The G.711MU and G.729A codecs are supported by ThinkTel. G.711MU was
configured as the preferred codec for the compliance test as shown below.

Select T38 Fallback for Fax Transport Support so that Avaya IP Office uses T.38 for
sending and receiving faxes on this SIP line. If the called destination does not support T.38,
the system will send a re-INVITE to change the transport method to G.711 (for falling back
to G.711 pass-through fax).

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones as out-band RTP events as per RFC2833.

Uncheck the VolP Silence Suppression option box.

Verify that Allow Direct Media Path is disabled (see the Direct Media item in the
observation/limitation list in Section 2.2).

Check the Re-invite Supported option box.

Check the PRACK/100rel Supported option box. This setting enables support by Avaya IP
Office for the PRACK (Provisional Reliable Acknowledgement) message on SIP trunks.

SIP Line -Line 17 - X v]<]s

SIP Line | Transport| SIP URI| ¥0IP  |T38 Fax |SIP Credentials

|[] ValIP Silence Suppressionl

Allow Direct Media Path

-
|Codec Selection | Custom e I |[4] Re-invite Supported |
Unused Selected
[G.711 ALAW 64K | [ > || [6.711 utaw e4k [ Codex Lckedoan
G722 64K |G.729({a) 8K CS-ACELP |[] Prack/100rel Supported |

16,7231 6K3 MP-MLQ
Force direct media with phones

[] G.711 Fax ECAN

Fax Transport Support §WT38 Fallback v

Location ?_Cloud b

Call Initiation Timeout (s) ‘j =

DTMF Support \RFC2833 v
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5.5. Short Code

Define a short code to route outbound calls to the SIP Line. To create a short code, right-click on
Short Code in the Navigation Pane and select New (not shown). On the Short Code tab in the
Details Pane, configure the parameters as shown below:

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. The 9N; short code, used for the compliance test, will be invoked when the user dials
9 followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.250.100”. This field is used to construct the
Request URI and the To header in the outgoing SIP INVITE message. The value N
represents the number dialed by the user. The IP address following the @ sign is the IP
address of the ThinkTel access interface towards which the outbound call is sent.

e Setthe Line Group Id to the Outgoing Group number defined on the SIP URI tab on the
SIP Line in Section 5.4.5. This short code will use this line group when placing the outbound

IP Offices 7 9N;: Dial* k-G X|lvli<|>
- R BOOTP (2) Short Code
# ¢/ Operator (3) —
(=% Jersey City Code ?N;
(%% System (1) = |
£ Line () Feature Dial v
<= Control Unit (2) Telephone Number | N'@192.168.250.100"
[# 4 Extension (17) =
# @ User(18) Line Group 1D |17 2l
(5§ Group (1) - - 7
R " chort Code (66) Locale United States (US English) v
@ service (0) Force Account Code  [[]
o RAS (1)

@ Incoming Call Route (15)
€2 wan port (0)
s Directory (0)
£ Time Profile (0)
® @ Firewall Profile (1)
[l 1P Route (4)
& Account Code (0)
. License (64)
W& Tunnel (0}
# §3 User Rights (8)
¢ ARS (2)
" RAS Location Request (0}
5 Location (0)
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The simple 9N; short code illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the dialed digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the screen below, the short code 8N; is illustrated for
access to ARS. When the Avaya IP Office user dials 8 plus any number N, rather than being directed to a
specific Line Group Id, the call is directed to 50: Main, configurable via ARS. See Section 5.8 for
example ARS route configuration.

E 8N;: Dial k- X|v|<]|>

Short Code
Code |BN;
Feature :Dial v |

Telephone Number M

Line Group ID ;50: Main v |

Locale v

Force Account Code  []

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N; short
code except that the Telephone Number field begins with the letter W, which means “withhold the
outgoing calling line identification”. In the case of the compliance test, when a user dialed *67 plus
the number, Avaya IP Office would include the user’s telephone number (DID number assigned to
the user) in the P-Asserted-ldentity (PAI) header and would include the Privacy: id header in the
outbound INVITE message. Consequently ThinkTel would prevent presentation of the caller id to
the called PSTN destination.

*67N;: Dial* ek -8 X | v|<]>

| Short Code |

Code [*67N;

Feature | Dial

| [

Telephone Number jWN"@192. 168.250,100"

Line Group ID |17 v |

Locale |United States (US Englsh) v

Force Account Code [
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line.
To configure these settings, first navigate to User->Name in the Navigation Pane, where Name is
the name of the user to be modified. In the example below, the name of the user is Tony 9611 at
extension 256. Select the SIP tab in the Details Pane. The SIP Name and Contact are set to one of
the DID numbers provided by ThinkTel. The SIP Display Name (Alias) can optionally be
configured with a descriptive text string. The value entered for the Contact field will be used in the
Contact header for outgoing SIP INVITE to the service provider. The value entered for the SIP
Name is used as the user part of the SIP URI in the From header for outgoing SIP trunk call
INVITE.

If outbound calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network (or
alternatively use the *67N; short code as defined in Section 5.5).

IP Offices B Tony 9611: 256 ek -E X vi<]|

- R BOOTP (2)
{7 Operator (3)
2y Jersey City
S 79 System (1) SIP Name 4388960445
%20 Jersey City —
17 Line (8) SIP Display Name (Alias) |Tony 9611
<= Control Unit (2) :
[+ 4 Extension {17) Contact biietind
=§ User(18)
frg MoUser
§rg RemoteManager
251 Allan 9630
201 Extn201
202 Extn202
| 203 Extn203
| 204 Extn204
| 205 Extnz05
| 206 Extn206
207 Extn207
208 Extn208
) 252 James 1616
e 258 Jim 1120E
e 253 John Softphone
e 259 Juan FlareWin
e 255 RW FlareWin
jer 257 Taili 1140E
[+ 53¢ Group (1)

User || Voicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In | Yoice Recording || Button Programming | Menu Programming

Mobility | Group Membership | Announcements | SIP Personal Directory

[[] Anonymous

The following screen shows the similar SIP settings for an analog extension user for fax:

Ko

= Extn208: 208 k-E | X|v<|>

User | Yoicemail | DND || Short Codes | Source Mumbers | Telephony | Forwarding | Dial In | Yoice Recording | Button Programming | Menu Programming
Mobility | Group Membership Announcements; SIP | Personal Directory

SIP Name 4388960447
SIP Display Name (alias) |Extn208 FAX

Contact [4388960447

[ anonymous
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5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, right-click Incoming Call Route in the Navigation Pane and select New (not
shown). On the Standard tab in the Details Pane, enter the parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the Incoming Group of the SIP Line defined in Section 5.4.5.
e Set the Incoming Number to the incoming DID number on which this route should match.

IP Offices B 17 4388960445 ek -EIX|vi<|>

®- & BOOTP (2) Standard | vaice Recording | Destinations
[+ ¢/ Operator {3)
Jersey City -
% System (1) Bearer Capability Any Voice
5y Jersey City —

17 Line (8) Line Group ID 17 v
(-2 Control Unit (2) Incoming Mumber 4383960445
[+ 4 Extension {17)
# & User (18) Incoming Sub Address
[ 5§ Group (1) -
& 8% Short Code (66) Incoming CLL ]
¥ @ service (0) Locale United States (US English) v |
o RAS(1)
= € Incoming Call Route (13) Priotity 1-Low v
@1 — '
@ i} Tag
i} A 7
v
@ 17 17207291055 Hold Music Source System Source |
0 17 4388960435 Ring Tone Override MNone Nt
@ 17 4338960444 3
17117 4385960445

@ 17 4388960447
@ 17 4388960449

On the Destinations tab, select the destination from the pull-down list of the Destination field. In
this example, incoming calls to the DID number 14388960445 on Incoming Group 17 are to be
routed to the user “Tony 9611 at extension 256.

= 17 4388960445 ek-E [ X|vlc]|>
| Standard || Yoice Recording Destinations
TimeProfile Destination Fallback Extension
> Default Yalue 256 Tony 9611 v v

The screen below shows calls routed to IP Office Voicemail Pro for message retrieval.

= 17 4388960444 kS [ X[wvl<]>
| Standard | voice Recording Destinations |
TimeProfile Destination Fallback Extension
» Default Value YoiceMail v v
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5.8. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these Application
Notes, this section includes basic ARS screen illustration and considerations. ARS is shown here mainly
to illustrate alternate routing should the SIP Line be out of service or temporarily not responding.

Optionally, ARS can be used to supplement or replace the simple 9N; short code approach documented
in Section 5.5. With ARS, secondary dial tone can be provided after the access code, time-based routing
criteria can be introduced, and alternate routing can be specified so that a call can re-route automatically
if the primary route or outgoing line group is not available. ARS also facilitates more specific dialed
telephone number matching, enabling immediate routing and alternate treatment for different types of
numbers following the access code. For example, if all local and long distance calls should use the SIP
Line, but service numbers should prefer a different outgoing line group, ARS can be used to distinguish
between the two call patterns.

To add a new ARS route, right-click ARS in the Navigation Pane and select New (not shown). To view
or edit an existing ARS route, expand ARS in the Navigation Pane and select a route name.

The following screen shows an example ARS configuration for the route named 50: Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form.
If the In Service box is un-checked, calls are routed to the ARS route name specified in the Out of
Service Route parameter. IP Office short codes may also be defined to allow an ARS route to be
disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route and the
means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other
known service-affecting events for the primary route.

IP Offices Ei Main® ek-BIX|vi<|>

®- & BOOTP(2) ARS
#- ¢/ Operator (3)
(=% Jersey City ARS Route Id Secondary Dial tone
=) %= System (1) B
%% Jersey City Route Name |SystemTone b
)14 Line (8)
“= Control Unit (2) Dial Delay Time System Default (4) 3 Check User Call Barring
|4 Extension {17) -
|- @ User(18)
Q Group (1) In Service Out of Service Route 51: backup v
|- 8% Short Code (66) -
B service (0)
o, RAS (1) -
] Q Incoming Call Route (13) Time Profile — - QUE 0 Hours Route <None> v
2 wan Port (0) l
a4 Directory (0)

£ Time Profile (0) !
) @ Firewall Profile (1) Code Telephone Number Feature Line Group ID
) Jill IP Route (4) 911 911 Dial Emergency [1]
#m Account Code (0) I; N'@192.168.250.100" Dial 17
%2, License (64)
W% Tunnel (0}
| §3 User Rights ()
| ¢ ARS (2)
€
"¢ 51: backup
" RAS Location Request (0) l
i Location (0)
Alternate Route Priority Level I3 v l

l

Alternate Route Wait Time 30 3 | m——)  fi|ternate Route 51: backup v

R RS R S

IR

&

+

Remove

Edit...

&
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Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 8N; in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per the
example screen above, if the user dialed 8-911, the call would be directed to Line Group 0 to be sent out
to the local area emergency response center (note that a short code 911 can also be configured to send the
emergency call out when the user simply dials 911). If the user dialed 8 + any other number, the call
would be directed to Line Group 17 as configured in Section 5.4.5. If the primary route cannot be used,
the call can automatically route to the route name specified in the Alternate Route field in the lower
right of the screen (51: Backup). Since alternate routing is considered a privilege not available to all
callers, IP Office can control access to the alternate route by comparing the calling user’s priority,
configured in the User tab of individual users, to the value in the Alternate Route Priority Level field.

5.9. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. By default, Avaya IP Office Release 9.0 sends out OPTIONS every 300 seconds. The rate at
which the messages are sent is determined by the combination of the Binding Refresh Time (in
seconds) set on the Network Topology tab in Section 5.2.1 and the SIP_OPTIONS_PERIOD
parameter (in minutes) that can be set on the Source Number tab of the noUser user. The
OPTIONS period is determined in the following manner:

e To use the default value, set Binding Refresh Time to 300. OPTIONS will be sent at the
300 second frequency.

e To establish a period of less than 300 seconds, do not define the SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 300 seconds. The
OPTIONS message period will be equal to the Binding Refresh Time setting.

e To establish a period greater than 300 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 300
seconds. The OPTIONS message period will be the smaller of the Binding Refresh Time
and the SIP_OPTIONS_PERIOD settings.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = noUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

IP Offices B NoUser: gk-E X vl<]|>
)= :Ttm! Unit1§2) | | Mobility | Group Membership | Announcements | SIP Personal Directory
& Extension
z f User ( IIB) an User || voicemail | DND | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In | Woice Recording | Button Programming | Menu Programming
g Moser Source Number -
f RemoteManager m
| 251 Allan 9630 Remove
| 201 Extn201
§ 202 Extn202 Edit...
| 203 Extn203
§ 204 Extnz04
| 205 Extn20S
| 206 Extn206
207 Extn207
| 208 Extn208
® 252 James 1616
e 258 Jim 1120E
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At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

Mew Source Number

Source Number |SIP_OPTIONS_PERIOD=6

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. Click OK at the bottom of the screen (not shown).

ﬁ NoUser: * e -9 | X | v|<]|>

Menu Programming | Mobility | Group Membership | Announcements | SIP Personal Directory

User | Yoicemail | DND | Short Codes? Source Mumbers :Telephony Forwarding || Dial In | Voice Recording || Button Programming |

Source Mumber
|

| SIP_OPTIONS_PERIOD=6 [

Remove

Edit...

For the compliance test, an OPTIONS period of 3 minutes was desired. The Binding Refresh
Time was set to 180 seconds in Section 5.2.1. Thus, there was no need to define
SIP_OPTIONS_PERIOD.
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5.10. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “anonymous”. Avaya [P
Office can be configured to use the P-Preferred-lIdentity (PPI) or P-Asserted-ldentity (PAI) header to
pass the actual calling party information for authentication and billing. By default, Avaya IP Office
uses PPI for privacy.

To configure Avaya IP Office to use PAI for privacy calls, select NoUser under User in the
Navigation Pane, then select the Source Numbers tab in the Details Pane as shown in the first
screen in Section 5.9. Click the Add button.

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI_FOR_PRIVACY. Click OK.

Mew Source Murber
K

Source Number SIP_USE_PAI_FOR_PRIVACY

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below. Click OK at the bottom of the screen (not shown).

NoUser: * B - X wl<]|=

Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership | Announcements | SIP Personal Directory

User | Voicemail | DND ShortCodes | Source Mumbers | Telsphony | Forwarding | Dial In || Yoice Recording | Butkon Programming

SIP_IUSE_PAL_FOR_PRIVACZY
Remove

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 33 of 38
SPOC 10/3/2014 ©2014 Avaya Inc. All Rights Reserved. TT-SipTrkIPO9



5.11. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following Save Configuration screen will appear, with either Merge or Immediate selected,
based on the nature of the configuration changes made since the last save. Note that clicking OK
may cause a service disruption. Click OK to proceed.

Save Configuration

IP Office Settings
Jersey City

Configuration Reboot Mode
(%) Merge

() Immediate

() When Free

) Timed

Reboot Time

Call Barring

| o

J[ Cancel ][ Help ]

6. ThinkTel SIP Trunking Configuration
ThinkTel is responsible for the configuration of the ThinkTel SIP Trunking Service. The customer
will need to provide the IP address used to reach the Avaya IP Office at the enterprise site (i.e., the
IP address of the LANZ2 port on the Avaya IP Office). ThinkTel will provide the customer the

necessary information to configure the Avaya IP Office including:

AMC; Reviewed:
SPOC 10/3/2014

Solution & Interoperability Test Lab Application Notes
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Access interface IP address of the ThinkTel SIP Trunking Service.
Transport and port for the SIP connection to the enterprise site.
DID numbers to assign to users at the enterprise.

Supported codecs and their preference order.
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7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly

7.1. System Status
Use the Avaya IP Office System Status application to check the SIP Line channels state and alarms:

e Launch the application from Start - Programs - IP Office - System Status on the
Avaya IP Office Manager PC. Select the SIP Line under Trunks from the left pane. In the
Status tab in the right pane, verify the Current State is Idle for channels not taken by active
calls; the state should be Connected for the channels engaged in active calls.

ffice System Status - Jersey City (10.32.128.30) - IP500 ¥2 9.0.3.0 build 941 = E@
IP Office System Status

Help Snapshot LogOff Exit  About

K System
1 & Alarms (7)
K Extensions (10)

Status | Ukilization Summary Alarms  Registration

SIP Trunk Summary

B Trunks (8)
Lines:1-4 Peer Domain Name: 192.168.250.100
’_ Resolved Address: 192.168.250.100
::::: :: Line Mumber: 17
Line: 20 Number of Administered Channels: 10
Active Calls Mumber of Channels in Use: 2
K Resources Administered Compression: G711 Mu, G729 &
K Voicemail : Silence Suppression: OFF
i Lpo':j:i::?;k"'g Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: Unlimited ‘ 1%
SIP Trunk Channel Licenses in Use: 2
SIP Device Features: REFER (Incoming and Outgoing)

Chan U... Call  Current Time in Re... Codec C... C. Other Party onCall Direction Round Receive Receive Transmit Tr.
nel - Ref State State of Call  Trip D... Jitter P Jitter

1 1 | 73 | Connected | 00:02:25 |20...|G711 Mu |R... |...[Extn 256, Tony 9611 |Incoming| 37ms 2.1ms
2 0 | 74 | Connected | 00:02:07 (20...|G711 Mu |R... Extn 258, Jim 1120E |Outgoing| 28ms 1.6ms
3 Idle 2days0...
4 Idle 2days Q...
S Idle 2 days 0...
6 Idle 2 days0...
7 Idle 2 days 0...
g Idle 2 days 0...
9 Idle 2 days0...
10 Idle 2 days0...
Trace [ Trace all ] [ Pause } [ Ping ] Call Details [ Print... ] [ Save As... ]

e Select the Alarms tab and verify that no alarms are active on the SIP Line.

Status  Utilization Summarsy: Alarms Reaistration

alarms for Line: 17 SIP 192.168.250.100

Last Date OF Error Occurrences Error Description
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7.2. Monitor

The Monitor application can be used to monitor and troubleshoot Avaya IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor on the Avaya IP Office Manager PC.
The application allows monitored information to be customized. To customize, select Filters >
Trace Options... as shown below:

£ Avaya IP Office SysMonitor - [STOPPED] Monitoring 10.32.128.30 ; Log Settings - C:\Documents and Settingsk...\sip... Q@@
File Edit View BEEEN Status Help

2R »E |Trace Options ... Cbrl+T | &*
I"i Send To Syslog

The following screen shows the SIP tab of trace options. In this example, Standard SIP Events and
the SIP Rx and SIP Tx boxes are checked.

All Settings @

T | YPN | WAN | SCN | Jade |
ATM | cal | DTE | EConf | FrameRelay | GOD | H323 | Interface |
ISDN | Key/Lamp | Directory | Media | PPP | B2 | Routing | Services SIP |System|

Events

WV Sip {m [~ STUN [~ SIP Dect
Packets

[~ SIP Reg/Opt Rx [~ SIP Misc Rz

[~ SIP Reg/Opt Tx [ SIP Misc Tx

[~ SIPCalR [~ Cm Naotify Rz

[~ Cm Notify Tx
v SipRx IP Filter (nnh.nnn.nhn.nnn)
V SipTx [
Default AIII Clear All | Tab CIearAHl Tab SelAII‘ oK Cancel
Save File I Load File l Load Partial File | Select File |
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8. Conclusion

The ThinkTel SIP Trunking Service passed compliance testing with Avaya IP Office Release 9.0.3.
These Application Notes describe the procedures required to configure the connectivity between
Avaya IP Office Release 9.0.3 and the ThinkTel SIP Trunking Service as shown in Figure 1. Test
results and observations are noted in Section 2.2.
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Product documentation for Avaya products may be found at http://support.avaya.com.

Product documentation for ThinkTel SIP Trunking Service is available from ThinkTel.
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are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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